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INTRODUCTION TO
Congratulations - you have just bought a photographic
memory! C-Pen is a Mobile Information Collector that reads,
remembers, processes and transfers printed text to your Win-
dows-equipped PC and PDA products. C-Pen is in essence
an electronic highlighter that saves the text you are mark-
ing. Carry it with you wherever you go!

Make it a habit to take your portable text collector with
you, and you are always ready to read and save text from
books, papers, brochures or business cards. You can easily
record price-lists, timetables, wine tips or witty quotes. You
don’t have to tear out pages any more.

With the portable dictionary you can translate and look up
words immediately without carrying around a printed
dictionary!

Your saved text files can later be transferred to your PC. It is
also possible to use C-Pen to read text directly into a Win-
dows application in your PC.

C-Pen Models
In order to accommodate different needs, several C-Pen
models are available. They all have the basic features
C Read, C Write and Notes. The set of applications
depends on the model. C-Pen 600MX is equipped with
applications such as C Dictionary and Storage and has the
ability to read the Cyrillic alphabet. On the following pages
you will find a short description of C-Pen 600MX and its
applications.

For more information on C-Pen, please refer to our webpage:
http://www.cpen.com.
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C-Pen 600MX
C-Pen 600MX combines the reading function with transla-
tion ability, making it the perfect companion when travel-
ling or studying.

C-Pen 600MX includes:

• C Read • C Direct • Info
• C Write • Notes • Storage
• C Beam • C Dictionary

C-Pen 600MX has the ability to read both the Latin and
the Cyrillic alphabet. It reads polish, hungarian, czech and
russian as well as the languages that other C-Pens read.

C-Pen 600MX offers communication by cable as well as
by IR.

It is powered by two alkaline AAA batteries (1.5 V type,
LR03). See further important instructions, Battery,  p.17.

C-Pen 600MX has a Trigg button, that you press while
reading, and an ESC button. It is possible to exchange the
functions between these two buttons.

For more information on C-Pen 600MX, please refer to our
webpage: http://www.cpen.com.
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Your Personal Digital Assistant

Powerful features
• C Read

Reads in text - the basic function of C-Pen. Move C-Pen
over the text, and the text will be captured by the pen,
where it can be saved as a file for later processing.

• C Write (only the Latin alphabet)
Allows you to enter characters by writing with C-Pen as
if it were an ordinary pen. This is useful when editing
text, entering file names and looking up words in C Dic-
tionary

• C Direct
Enables you to transfer the scanned text directly from C-
Pen into your PC. The text will be placed at the cursor
position in any Windows program.

• C Beam
Transfers notes, contacts, calendar events and files be-
tween C-Pen and PDAs. C Beam supports the standard
infrared protocol IrOBEX. All devices and applications
using the IrOBEX protocol to its full extent are fully
compatible with C-Pen.

• C Dictionary
Enables your C-Pen to translate and/or look up words. C
Dictionary is very easy to use, simply slide your C-Pen
over the word you require translated and within less than
a second the result is displayed. Several language soft-
ware packages are available.
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• Storage
Storage area in C-Pen, which can be used as a floppy
disc for files.

Optimal Reading Conditions
C-Pen uses Optical Character Recognition (OCR) to read
text. OCR is the process of turning an image of characters
into computer-readable text.

As C-Pen moves over the text, its internal light source illu-
minates the characters and a camera takes pictures of the
text. During OCR, C-Pen analyzes the pictures taken by its
camera and translates them into text characters.

The OCR quality will depend on the reading conditions.
The letters most commonly confused using OCR are:

e → c l → I t → c

r+n → m i → l c → o

The following conditions affect the quality of character
recognition:

• The print quality of the text
High-quality printed text naturally gives maximum
OCR accuracy. With lower-quality print, e.g. faxes,
OCR accuracy may be poorer. You can calibrate the
C-Pen to optimize its performance under difficult
conditions; see Calibration, p. 56.

Please note that C-Pen only recognizes machine-printed
characters such as laser-printed or typewritten text.
C-Pen does not recognize handwritten text.

!
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• Position and movement of C-Pen
It is important how you hold and move C-Pen over the
printed text. Please see Reading text, p. 22  or read the
Quick Start folder to learn how to use
C-Pen correctly. It is crucial that you follow these
instructions in order to get the best results.

• The language of the text
Set the text language of the text you wish to read, to
get the most suitable OCR. See Text Language, p. 55.

• Deformed characters
Anything that is not a printed character, and any
character distorted by a mark or smudge on the paper
may be unrecognizable.

• Overlapping characters
Characters in the text should not overlap.

• Italics and underlined text
Italics are slightly difficult for C-Pen to read in some
fonts. Underlined text is also difficult for C-Pen to
read because the underline changes the shapes of the
descenders of the letters g, j, p, q and y.

• Text colors - text and surface
C-Pen cannot read some combinations of text colors
on colored surfaces, such as red or yellow text on a
white or red background.

Text that is highlighted by a traditional highlighter
marker can be read in some cases, depending on the
color and darkness of the ink.

• Small or large character sizes
The size of the characters should be 5–22 points.

Download from Www.Somanuals.com. All Manuals Search And Download.



10

User Documentation and Support
There are several sources of support for your C-Pen.

This User's Guide contains a description of C-Pen, its ap-
plications and instructions for reading and editing text and
saving files. The following applications are explained:

• C Read • C Direct • Storage

• C Write • C Beam • C Dictionary

• Notes • Info • Settings

You can also learn how to connect C-Pen to a PC.

The enclosed C-Pen CD contains the C-Win Software for
communication between C-Pen and your PC. It also con-
tains several help files:

• Help

• User's Guide in several different languages

• Troubleshooting, which helps you solve many
problems

On our web site, www.cpen.com, you can find Trouble-
shooting and the User’s Guide translated into several lan-
guages. Visit our web site, www.cpen.com, to get the latest
C-Pen news and free software upgrades.

Care and Safety
• Keep C-Pen away from direct sunlight, heat, moisture

and dust.

• Do not expose C-Pen to extreme temperature
variations.
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• Make sure the camera opening is free from dust or any
other objects.

• Do not deliberately insert any object into the camera
opening.

• Clean C-Pen with a dry cloth. Do not use detergents or
other chemicals when cleaning C-Pen.

• C-Pen models that are powered by alkaline batteries,
require two 1.5 V AAA batteries of type LR03. See
Battery, p. 17.

• Make backup copies of your C-Pen files regularly and
keep the copies in a safe place. Copies are made using
C-Win Software, see Using C-Pen with your PC, p. 71.
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PRESENTATION OF C-PEN

Parts of C-Pen
Description of the different parts:

1
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5

5
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1. On/Off and Nav
Turns C-Pen on or off when pressed and held for more
than two seconds. This button is also used to scroll
through the menus and texts (push up or down) and to
select an item or an option (press briefly).

2. ESC
Closes menus. This is the button on the side of C-Pen.
The functions of Trigg and ESC can be exchanged to
suit your own preferences. See System Settings, p. 59.

3. Display
Used to display scanned text and for communication
between C-Pen and the user. The orientation of the text
on the display can be changed to suit left-handed users.
See System Settings, p. 59.

4. IR port
The infrared (IR) port is used for wireless data transfer
between C-Pen and a PC, mobile phone or PDA  that is
equipped with an IR port.

5. Trigg
The Trigg button is to be pressed and held down while
reading text. The functions of Trigg and ESC can be
exchanged to suit your own preferences. See System
Settings, p. 59.

6. Cable Socket
The Cable Socket is where you plug in the cable that
connects C-Pen to your PC. The cable is used to com-
municate and transfer files to and from C-Pen to
your PC.
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7. Battery Compartment
This is where you insert the batteries.

8. Camera Opening
The Camera Opening is not protected in any way.
This enhances C-Pen’s reading ability but it also
makes it important to see to that dust or other objects
do not enter the camera opening.

Display Objects
C-Pen uses the following display objects to communicate
with you:

• status field

• application icons

• menus

• check boxes

• dialog boxes

• edit fields

• dialog buttons

Status field
The area on the left side of the display is called the status
field. This field can display the current application, text
settings (Text Quality and Text Language) and C-Pen’s
battery power level. See also Settings, p. 54 and Battery, p.
17.
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Application icons
The applications are represented by application icons on
the main screen. The applications are described in the chap-
ter Applications, p. 39.

 

Menus
Menus provide different options. A scroll bar indicates if
there are more menu items available above or below the
visible section.

Check boxes
Check boxes also provide different options. A check box
remains checked until you uncheck it or check another of
the alternative boxes in the list.

C-Pen main screen
Application icons

Menu items

Menu

Scroll bar

Text LanguageBattery power level

Text Quality
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Dialog boxes

A dialog box appears when you need to enter information or
give commands to C-Pen. A dialog box contains one or more
objects such as edit fields or dialog buttons.

Edit fields
It is possible to enter and edit text in an edit field. An edit
field is recognized by its frame, see the figure above.

Dialog buttons
Dialog buttons are used in dialog boxes to give simple
instructions to C-Pen.

Common dialog buttons

Edit field

Dialog box
Dialog buttons

Checked box
Unchecked box
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GETTING STARTED

Turning C-Pen On and Off
To turn C-Pen on and off, press the On/Off button until the
display is activated/deactivated. C-Pen turns off automati-
cally after 5 minutes of  inactivity. To change the auto-
matic power-off time, see System Settings, p. 59.

Battery

Installing the batteries
1. Remove the battery cover from the back of C-Pen.

  

It is imperative to observe the polarity of the batteries.
The orientation of the plus and minus ends is shown
inside the battery compartment.

Press Nav to turn C-Pen on and off

Lift the cover here to open

!
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2. Insert two alkaline AAA batteries (1.5 V, type LR03).

3. Replace the battery cover. You should hear a “click”
when it locks in place.

Please do not dispose of batteries in a fire as there is a
danger of explosion. Please recycle the batteries!

Battery power level
The battery power level is shown by the battery indicator
at the bottom of the status field.

If the battery power level is getting low, the message “Bat-
tery low” will appear on the display. To avoid losing un-
saved information, save all material not previously saved
and then change the batteries. Turn C-Pen off before chang-
ing batteries. To change batteries, see Installing the bat-
teries p. 17.

If the battery power level is so low that the pen can no
longer function, you will get the message “Battery level
too low! Shutting down.” You must change the batteries to
be able to continue using C-Pen.

!

Text LanguageBattery power level

Text Quality
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Please note that information may be lost if you remove the
batteries without turning C-Pen off first. However, when
you turn C-Pen off properly, all information is saved in
the memory and it is safe to remove the batteries.

C-Pen is reset by removing the batteries from the battery
compartment. Do this when C-Pen has encountered
problems or has “frozen”.

Navigating and Selecting
Nav (the navigation control) is used for navigation and to
select an object.

Turn Nav up or down to navigate between

• menu items

• dialog buttons

• edit fields

• check boxes

• lines or characters in text

As you move between objects, they become highlighted
(inverted).

Pressing Nav briefly when an object is highlighted is re-
ferred to as selecting that object.

The result when selecting an object is explained for each
situation later in this manual. Below are some general re-
marks about selecting objects.

!

Download from Www.Somanuals.com. All Manuals Search And Download.



20

Menus
Selecting a menu item marked with a  will display
further alternatives in a new menu.

Selecting EXIT or CANCEL will close the menu. Instead of
selecting EXIT or CANCEL, you can press ESC.

 

Dialog buttons
In a dialog box you can instruct C-Pen how to continue by
selecting a dialog button:

• OK

You accept a suggestion in a dialog box.

• YES

Your answer is “Yes” to a question in a dialog box.

• NO

Your answer is “No” to a question in a dialog box.

• CANCEL

The dialog box is closed and you return to your earlier
menu or screen. Instead of selecting CANCEL, you can
press ESC.

Edit fields
To be able to edit text in an edit field, you must first select
the field.

Menu item with
alternatives
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A cursor will appear in the edit field and the status field
will show the edit mode symbol. See Editing text, p. 26.

 

Check boxes
To mark an alternative in a list of check boxes, navigate to
the alternative of your choice (using the Nav button).

 

Mark the alternative by selecting it (press the Nav button
briefly).

 

The check box becomes checked and the OK button is
highlighted. Press OK if you are satisfied with your choice,
otherwise press CANCEL.

Edit field

Press to select an object

Cursor

Edit mode symbol
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READING AND SAVING TEXT
Please follow the instructions in this chapter in order to get
the best results from your C-Pen. Take a few minutes to
learn how to use C-Pen correctly. See also Optimal Read-
ing Conditions p. 8.

In this User's Guide “read text” should be interpreted as
reading a line of text, not a line on C-Pen’s display.

Reading Text
To read a line, follow the steps below.

1. Turn C-Pen on. Make sure the text settings are set to
the appropriate values. The text settings are Text
Language, Read Mode and Text Quality. It is also
possible to calibrate C-Pen for best performance. See
Settings, p. 54.

2. Place C-Pen over the first character you want to read.
Hold C-Pen with the pen tip flat against the surface.
Make sure that the camera opening covers the entire
height of the line. C-Pen reads one line at a time.

3. Press and hold Trigg.
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Please note that the text surface must be completely flat in
order to achieve maximum reading accuracy.

4. Move C-Pen over the line of text, keeping Trigg
pressed. You can move C-Pen left-to-right or right-to-
left over the text. You can read up to 15 cm/second (5
inches/second).

5. Release Trigg at the end of the line.

!
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Text screen

Continued reading
The Text screen will appear on the display.

 

The text is placed in a new text file in Notes, see p. 41. You
can also create a new, empty text file by selecting New...
and then FILE in Notes, before you start reading.

Reading another line
Read the second line in the same way as you read the first.
A space, a line break or a tab is inserted between the lines,
see Read Mode, p. 55. You can insert a line break by press-
ing Trigg.

The last line is highlighted (negative), i.e. light text on a
dark background. To delete the last line, press ESC briefly.

Deleting a line
To delete any of the lines you have read, proceed as
follows.

1. Move the cursor (the flashing triangle) with the Nav
button to the beginning of the line. Press Nav and the
Text menu opens, see p. 43.

2. Scroll through the menu items until you find Select
and press Nav. The line becomes highlighted.

3. Press ESC briefly. The line disappears and you are
ready to read a new line.
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Saving Text
Press Nav to open the Text menu (see Notes, p. 41) and
choose Exit. The Save As dialog box appears. Choose YES
if you want to save the text, NO if you want to discard the
text or CANCEL if you want to return to the text. The dialog
box contains an edit field with a suggested file name. You
can change the file name before you save the file; see
Editing text in the next section.
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EDITING TEXT
To be able to edit text in a text file or in an edit field you must
enter edit mode.

Entering Edit Mode
You can enter edit mode in different ways depending on
your starting-point. You can enter edit mode from the Text
screen or from an edit field.

Entering edit mode from the Text screen
Press Nav in the Text screen to open the Text menu. Select
Edit/C Write to enter edit mode. You can now edit text
either by using the Edit menu (see below) or by using
C Write (see p. 31).

Entering edit mode in an edit field
Press Nav when the edit field is highlighted to enter edit
mode. You can now edit text either by using the Edit menu
(see below) or by using C Write (see p. 31).

Edit Menu
When you are in edit mode a cursor appears and the edit
mode symbol is shown in the status field.

 

CursorEdit mode symbol
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In edit mode you can move the cursor one character at a
time by turning Nav. You can move to the beginning or the
end of the text with the Go to option in the Edit menu.
Move the cursor to the position where you want to edit the
text. Press Nav to open the Edit menu.

The options in the Edit menu are slightly different, de-
pending on where you want to edit a field. The most common
items in the Edit menu are:

• Quit Editing
Exits edit mode in the Text screen.

• Done
Returns to the text from the edit mode in an edit field.

• Change
Changes the character to the right of the cursor.

• Insert
Inserts new characters, a space or a line break at the
cursor’s position.

• Cut
Cuts out the selected characters.

• Copy
Copies the selected characters.

Edit menu
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• Paste
Pastes a cut out or copied selection of characters.

• Delete
Deletes a character or a selection of characters.

• Go to
Moves the cursor to the beginning or the end of the text.

• Select
Highlights characters or an entire text.

• Settings
Sets the text settings (Text Language, Text Quality and
Read Mode) of the text you are reading. The options
Calibration and C Write Feedback are also included
here.

• Cancel
Closes the edit menu. Returns to the read text.

The menu items are explained in greater detail below.

Change
Place the cursor to the left of the character you want to
change and select Change from the menu. Turn Nav to
select the new character from the character set and then
press Nav.

 

The character set
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As default C Write Prototype Viewing is enabled. When
scrolling in the character set you can see how the charac-
ters should be drawn if you want to use C-Pen as a normal
pen during editing. C Write Prototype Viewing is auto-
matically turned on/off when C Write Feedback is  turned
on/off, see  p. 32.

Insert
Move the cursor to the place where you want to insert text,
and select Insert from the menu. You can choose between
inserting a space, a line break, a character or multiple char-
acters.

Select Character in the insert menu to insert one charac-
ter. Then turn Nav to select a character from the character
set and press Nav. The character set closes automatically
after insertion.

To insert more than one character, select Multiple Charac-
ters. Turn Nav to select a character from the character set
and press Nav. The character set remains on the display
and you can continue inserting characters.

As default C Write Prototype Viewing is enabled. When
scrolling in the character set you can see how the charac-
ters should be drawn if you want to use C-Pen as a normal
pen during editing. C Write Prototype Viewing is auto-
matically turned on/off when C Write Feedback is  turned
on/off, see  p. 32.

When you are finished, press ESC or the DONE button (in
the end of the character set) to return to the text you are
editing.
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Select
Use the Select command to edit more than one character at
a time. Then select Characters and turn Nav to mark mul-
tiple characters. Press Nav and choose Cut, Copy or Delete
from the menu. If you select All, the entire text will be se-
lected.

Cut, Copy and Paste
To be able to choose Cut, Copy or Paste you must have
selected part of a text. If you have chosen Cut or Copy you
can Paste the text section at the cursor’s position by press-
ing Nav and selecting Paste in the menu.

Delete
Place the cursor to the left of the character you want to
delete and select Delete from the menu. If you have se-
lected several words or lines, the whole selection will be
deleted, see Select above.

Settings
Detailed explanations of the settings are to be found in
Settings, p. 54. The available settings are:

• C Write Feedback
Mark/unmark the check box to switch the C Write vi-
sual feedback on/off, see p. 32.

• Text Language
Select the language of the text you are reading.

• Read Mode
Select Continuous or Separate lines.
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• Text Quality
Select Normal or Inverted.

• Calibration
You can either calibrate C-Pen or revert to the default
setting.

Quit Editing
Quit edit mode by selecting Quit Editing.

C Write
Please note that you can only use C Write for the Latin
alphabet.

C Write is a feature that allows you to draw characters by
using C-Pen as an ordinary pen. C-Pen can track its own
movement over a surface and recognize the movement as a
letter, digit or a symbol. C Write is an alternative to using
the character set when inserting characters in a text.

Please note that to be able to use C Write, the surface you
“write” on must have a distinct pattern. Printed text is the
best choice.

Use C Write in the following way:

1. Enter edit mode.

2. Position the cursor on C-Pen’s display.

3. Place C-Pen with the pen tip flat against a text surface.

4. Form a letter, see C Write Prototypes, p. 35. The Trigg
button must be pressed while forming the letter.

!

!
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5. Lift the pen from the surface. When the pen is lifted from
the surface an image will briefly appear on the display,
showing the letter as perceived by your C-Pen.

You do not have to wait for this image to disappear
to write your next letter.  The function is called
C Write Feedback, and is enabled as default.

The C Write Feedback utility can be switched on/off as
follows.

1. Go to Settings in the main screen.

2. Select C Write Feedback.

3. Uncheck/check the check box according to your per-
sonal preference.

4. Select OK.

Basic rules when using C Write
It is important that the pen tip is in contact with the surface
while you are writing. The Trigg button must be pressed
before you start writing.

The writing surface must have a distinct pattern, such as a
printed text. Solid colors or simple repetitive patterns (lines,
squares, grids) should be avoided.

Visual feedback
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In order to obtain maximum accuracy when writing with C-
Pen, your characters should resemble the prototypes on
the following pages as closely as possible.

A character must be drawn in one single stroke. The dot
indicates the starting point of the stroke, see next page.

The height of the character should be 1 - 4 cm
(¼ - 1¼ inch).

Capital letters
When you enter edit mode the status field will
change appearance. The edit mode symbol indi-
cates that C Write will generate lowercase
letters.

To write a capital letter, you have to write the shift
sign first, see C Write Prototypes. Only the first
letter will be a capital. The status field will reflect
this choice.

If you write two shift signs, C Write will enter
Caps Lock mode. All letters will be capitals until
you write a shift sign again.

Symbols
Press Trigg briefly to enter symbol mode.

C Write Capital letter icon

C Write Caps  Lock mode icon

C Write Lowercase icon
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The status field displays the Symbol mode icon.
Write one of the symbols in the symbol table.
After writing a symbol, C-Pen automatically
returns to normal mode.

If you want to quit symbol mode without writing a symbol,
you have to draw a backspace symbol.

C Write symbol mode icon
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C Write Prototypes
Letters, digits and shift

Shift Space Backspace New line

Aa Bb Cc Dd Ee

Ff Gg Hh Ii Jj

Kk Ll Mm Nn Oo
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Pp Qq Rr Ss Tt

Uu Vv XxWw Yy

Zz

1 2 3 4 5

6 7 8 9 0
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. , : ; / \

Special characters

Çç Ææ Øø

Accents and umlauts

Write the letter first and then the accent or umlaut.

Example: ä=a+

¨ º ^ ´ ` ~

Symbols

Enter symbol mode by pressing Trigg briefly.
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( ) [ ] { }

- + * $ @ “

# _ < > ? ¿

! ¡ £ § ß %
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APPLICATIONS
C-Pen’s application icons are shown on the main screen.
You can move between the icons by using Nav. Press Nav
to start an application.

 

Notes contains your read and stored text files.
See p. 41.

C Dictionary can read and translate words be-
tween the languages you have chosen for your
C-Pen. See p. 45.

Settings contains parameters which can be
changed such as power-off time and reading
options. See p. 54.

Info contains information about your C-Pen’s
serial number, OS (Operating System) version,
free memory space, etc. See p. 61.

Storage can store files for transfer between
computers. See p. 62.

C Direct contains information on how to trans-
fer text from C-Pen directly into a Windows pro-
gram. See p. 68 and 69.

C Beam is used to transfer notes, contacts, cal-
endar events and files between C-Pen and

C-Pen main screen

Download from Www.Somanuals.com. All Manuals Search And Download.



40

PDAs (Personal Digital Assistant). C Beam
supports the standard infrared protocol
IrOBEX. See p. 64.

C Write contains information about and ex-
amples of how to write letters with C-Pen. See
p. 31.

Download from Www.Somanuals.com. All Manuals Search And Download.



41

Notes
Notes contains the text files you have read and saved. Enter
Notes by selecting the Notes icon on the main screen.

 

Inside Notes, move between items using Nav.

You can transfer files from Notes in C-Pen to your PC. To
do this, C Win Software must be installed on your PC. See
Using C-Pen with your PC, p. 71.

Creating a new file or folder
Selecting New... will open a dialog box. Select FILE to
create a new file.

 

Please note that if you are in the main screen or in Notes
you do not have to execute this command to create a new
file. A new file will automatically be created when you
start to read with C-Pen (except when you are already in
the Text screen). New text files will be placed in Notes.

Select FOLDER to create a new folder. A dialog box ap-
pears. Select the edit field to give the folder a name.  Use
C-Pen to read a name or press Nav to enter edit mode and

Your list of text
files starts here

!
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then write a name with C Write. To save the folder, select
OK. The folder will be placed in Notes.

 

If you want to save a file in a specific folder, you must
create the file in that folder. Open the folder, select New...
and then select FILE in the dialog box.

The Command menu
The Command menu contains commands for handling
texts. Open the menu by selecting a text file and pressing
Nav.

 

The options in the Command menu are:

• Open
Opens the selected file.

• Rename
Renames the selected file. A dialog box with an edit
field appears.

• Delete
Removes the selected file.

Command menu
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• Properties
Displays the file size, and if applicable the creation
date and the date of last modification of the selected
file.

• Beam
Transfers the selected file by IR, see p. 64.

• Cancel
Closes the Command menu.

The Text menu
In the Text screen you can move the cursor line by line
with Nav. You can insert a new line at the cursor position
(the flashing triangle) by reading a new line with C-Pen.

 

Press Nav if you want to edit the text,  go to the beginning
or end of the text, change text settings or stop working with
the text. Pressing Nav opens the Text menu.

The items in the Text menu are:

• Exit
Closes the text. If the text has been changed you are
prompted to save it before it is closed.

Select SAVE AS... if you want to save the changed file
with a new name.

Text menu
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• Edit/C Write
Enters edit mode. See p. 26.

• Settings 

Opens the text settings of the text you are reading. See
Settings, p. 54.

• Select
Highlights a read line/word.

• Go to 

Moves the cursor to the beginning or the end of the
text.

• Cancel
Closes the Text menu.
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C Dictionary

Introduction
C Dictionary is a software application that allows you to
translate and/or look up definitions of words in less than a
second. Whether you translate or look up definitions de-
pends upon which dictionary you choose to install. With
bilingual dictionaries, you can translate from one language
to another. Some dictionaries are monolingual reference
dictionaries and with them you can look up definitions of
words.

C Dictionary translates or looks up words one word at a
time, the same way you would look up words in a paper
dictionary. You can however, scan in an entire line of text
and then choose which word you wish to look up.

Several kinds of dictionaries are available from a variety of
publishers. The dictionaries available for download are
copyrighted by their respective publisher. See Copyright
Notice for details, p. 88.

Before you start installing the dictionaries, make sure you
have a working connection between C-Pen and your PC.
See Using C-Pen with your PC, p. 71.

Installing a dictionary from the C-Pen CD
Follow the steps below to install a Dictionary.

1. The dictionaries are available in the Start menu/Pro-
grams/C-Pen/Dictionaries. Select the dictionary you
want. Dictionaries with cyrillic letters are only avail-
able on our homepage, see Installing a dictionary from

Download from Www.Somanuals.com. All Manuals Search And Download.



46

the web below. Make sure you have your C-Pen CD in
your CD-ROM drive.

Please note that dictionaries not available on the CD at the
time of going to press will be available on
www.cdictionary.com/mx/ as soon as they are made
available.

2. You can now see the C Dictionary Installer view. Make
sure the dictionaries you want are selected.

3. Start your C-Pen, position C-Pen so that it is aligned
with the PC’s IR port or ensure that the cable is con-
nected, then press Start.

4. The dictionary will now be transferred to your C-Pen.
This can take some time, so please be patient. The num-
ber of dictionaries that can be installed in C-Pen de-
pends on the amount of free memory in your C-Pen, see
Info, p. 61.

Installing a dictionary from the web
1. Download the dictionary you want from our web site

www.cdictionary.com/mx/.

2. Click on the file, and an automatic installation
program will start.

3. You can now see the C Dictionary Installer view. Make
sure the dictionaries you want are selected.

4. Start your C-Pen, position C-Pen so that it is aligned
with the PC’s IR port or ensure that the cable is con-
nected, then press Start.

5. The dictionary will now be transferred to your C-Pen.
This can take some time, so please be patient. The num-

!
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ber of dictionaries that can be installed in C-Pen de-
pends on the amount of free memory in your C-Pen.

Access to dictionaries
Dictionaries are protected from unauthorized use by a dic-
tionary license key. For more information about how to ob-
tain the license key, see www.cdictionary.com.

The user is requested to provide the license key to activate
a new dictionary in C-Pen (the DICTIONARIES button in
the C Dictionary application). The Enter License Key dia-
log box contains six number boxes. Enter the numbers one
by one using Nav.

 

If you enter the wrong license key four times in a row, the
dictionary will be removed. To try again, you must
reinstall the dictionary, see Installing... above. Once the
correct license key is entered, the dictionary is ready to
use.

Please make sure that you have the license key before
you upgrade your C-Pen or remove a dictionary. To
find your license key, select the info button on the
C Dictionary main screen in your C-Pen.

Removing a dictionary
To remove a dictionary from C-Pen, double-click on the My
C-Pen icon on your PC, select C Dictionary and then the

Enter
dictionary key

!
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dictionary you want to delete. Use the Delete command in
the File menu. You have to use your PC to remove a dictio-
nary from C-Pen.

Please make sure that you have the license key before
you delete a dictionary.

Using C Dictionary
Start C Dictionary by selecting the C Dictionary icon in
the main screen and press Nav.

 

C-Pen is now ready to translate/look up words. If you want
to change dictionaries before you start reading,
see DICTIONARIES button, p. 52.

 

To translate/look up a word, just read the word with C-Pen
as usual. One of the following events will occur:

1. The word is found in the dictionary and the transla-
tion/definition is presented on the screen, see Trans-
lation/definition screen p. 50.

2. No exact match of the word is found in the dictionary,
a list of alternatives is displayed, see Word selection
list, p. 51.

C-Pen
main screen

C Dictionary
main screen

Word edit box

The language from
which you want to
translate

!
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3. Several words are read. The words are shown on a new
screen where you can select the words to be translated/
looked up, see Word selection screen, p. 51.

4. A dialog box appears, telling you that the word
cannot be found in the dictionary.

When you are reading a word, the word (or part of the word)
in front of and/or behind the accurate word might also be
included. If this is the case C Dictionary acts according to
the following rules:

• If two words are read, the longest word is translated.

• If three words are read, the middle word is translated.

• If more than three words are read, the Word selection
screen is displayed, see next page.

Word edit box
The word/s you have read are directed to an edit box where
you can edit them in the usual way.

1. To be able to edit the word/s you have to close the
dialog boxes, lists or screens that might have been
opened after reading.

2. The edit box will already be selected. Press Nav and a
cursor will indicate that you are in edit mode.

3. Press Nav again to open the Edit menu or use C Write
to edit the word.

4. When you have finished editing, select Done in the
Edit menu or press ESC.

5. The edited word will now be looked up in the
dictionary.
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Word references
Some words in the dictionaries contain references to other
words. The references are displayed in bold italic style.

If you press Nav when a word reference is displayed, a
menu appears and you can choose to:

• look up the reference

• cancel the menu

• close the translation/definition containing the
reference

If you choose to look up the reference, the word will be
translated.

Translation/definition screen
The Translation/definition screen displays the translation
of the selected word. If only part of the text will fit on the
display a scroll bar will appear. Turn Nav to scroll the text.

 

The meaning of bold and italic characters is explained in
Info, see Info button p. 61.

To cancel the scanned word/text and go back to the C Dic-
tionary main screen, press Trigg briefly.

A new word can be read without closing the screen. Close
the Translation screen by pressing Nav or ESC.

Translation/
Definition
screen
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Word selection list
If the word being read does not match any word in the
dictionary, the application will search for similar words
and display alternatives in a Word selection list.

The most probable word is presented at the top of the list
with the others in descending order of probability. A maxi-
mum of ten words will be displayed. Select a word to see
the translation/definition.

The reason why a word cannot be found may be that the
word is misspelled or that the OCR has given an erroneous
result. Another reason can be that the word is inflected (e.g.
chairs instead of chair).

 

A Word selection list will be displayed if more than one
word is found with the same spelling as the word being
read, but with different meanings.

To cancel the word/text scanned and go back to the C Dic-
tionary main screen, press Trigg briefly.

You can start to read a new word without closing the list.
Close the Word selection list by selecting Cancel or by
pressing the ESC button.

Word selection screen
If more than three words are read the Word selection screen
appears. Turn Nav to select a word.

Word selection list
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C Dictionary
main screenDictionaries button

The selected word is looked up and the Translation/defi-
nition screen, Word selection list or Can’t find dialog box
will be displayed.

To cancel the scanned word/text and go back to the C Dic-
tionary main screen, press Trigg briefly.

 

You can start to read a new word without closing the screen.
Close the Word selection screen by pressing ESC or by
selecting the CANCEL button.

Text Language
The Text Language is automatically set to the language
you are translating from; i.e. German is set for the German-
English dictionary. Exiting C Dictionary will restore the
Text Language to the language that was set before enter-
ing C Dictionary.

Dictionaries button
The DICTIONARIES button in C Dictionary’s main screen
is shown below.

 

Word selection
screen
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The DICTIONARIES button gives you access to the list of
dictionaries in your C-Pen. Select the dictionary you want
to use by checking its check box, and then select OK.

If you want to use the same dictionary the next time you
use your C-Pen you do not have to repeat this procedure,
since the dictionary setting is stored when C-Pen is turned
off.

Info button
The INFO button displays information about the currently
selected dictionary, the number of words, the publisher of
the dictionary and copyright information. Your dictionary
license key is also shown here.

Before you upgrade your C-Pen or delete a dictionary,
make sure you have recorded the license key.

Exit C Dictionary
You can exit C Dictionary from the C Dictionary main
screen by selecting EXIT, or press ESC a few times until
you are back in C-Pen main screen.

!

!
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Settings 
Settings contains the parameters that control C-Pen. Enter
Settings from the Main screen by selecting the Settings
icon. You can also enter text settings from the Text menu,
p. 43 and the Edit menu, p. 26. A list of the available set-
tings appears.

The following settings are available:

• Text Language

• Read Mode

• Text Quality

• Beam Settings

• C Write Feedback

• Calibration

• System Settings

Text Language, Read Mode and Text Quality are referred
to as text settings. You should set up these settings to
achieve optimal OCR.

To modify a setting:

1. Turn Nav to highlight the setting you want to change.
Press Nav and a check box or menu appears.

2. Turn Nav to highlight the option you want and press
Nav to select the chosen value.

3. Select OK to close the dialog box and save the
changed setting.

4. Exit Settings by selecting Exit at the top of the
Settings menu, or alternatively press ESC.
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Text Language
Select the language of the text you want to read from the
list of languages, by checking the check box. If you only
intend to read numbers, select Numbers Only as the
language.

Read Mode
Read Mode adjusts C-Pen’s reading format. The options
are:

• Continuous
A space is inserted between two separate readings with
the C-Pen. Suitable when you read a complete paragraph
which will be used in a document on your PC.

• Separate lines
Each reading starts on a new line.

• Tab
Each reading starts after a tab.

Text Quality
Use this setting to indicate if the printed text is normal or
inverted (negative).

• Normal
Black text on white background.

• Inverted (negative)
White text on black background.
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Beam Settings
• Recieving files

Select the language of the file you are beaming to C-
Pen.

• Always send as Unicode
If enabled, all files will be sent in the Unicode
standard.

• Cancel
Return to Settings.

C Write Feedback
Check the check box if you want to enable/disable the
visual feedback facility in C Write.

Calibration
The Calibration option increases C-Pen’s reading ability
if the text is not black, if the background is not white, or if
the text quality is poor. During the calibration process,
C-Pen will find the appropriate balance of black and white
for the particular surface. If your C-Pen reads poorly, try to
calibrate it. However, the default settings should be able to
cope with most cases.

Calibration overrides the factory settings. The calibrated
setting is not saved when C-Pen is turned off. If you want to
revert to the factory setting without turning C-Pen off,
select Calibration in Settings and then Calibrate. Select
DEFAULT SETTING in the dialog box.

Inverted (negative) text must be reset in Text Quality.
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Please note that it is impossible to read red text.

If calibration does not improve the reading accuracy, return
to the default setting.

 

The Calibration menu contains three items:

1. Calibrate, where you can :

Calibrate immediately by moving the pen over the text sur-
face, see How to... p. 58, or return to the DEFAULT SETTING
which is the factory setting.

2. Options, where you can enable/disable the Quick
Calibration option.

Quick calibration is the preferred option if you often
read texts with very different text contrasts. Quick
calibration is disabled as default.

Quick calibration enables C-Pen to start a calibration
as soon as you press Trigg.

 

The pen tip should be pressed flat against the surface
and held, perfectly still, while you press Trigg for
about two seconds.

3. Cancel, return to the main menu.

!

Download from Www.Somanuals.com. All Manuals Search And Download.



58

How to Calibrate
Calibrate adjusts C-Pen’s reading ability according to the
contrast between the text and its background. When the C-
Pen display says “Press scan to calibrate”, follow these
instructions:

1. Hold C-Pen with the pen tip flat against the surface.

2. Press Trigg while moving the pen. If calibration is
performed from a menu other than the Settings main
menu, you should press Trigg, hold the pen still for
two seconds and then move it over the surface.

3. A progress indicator appears on C-Pen’s screen.

 

4. Move C-Pen over the text, in circles or back and forth.
Continue to move C-Pen until the progress bar is
complete.

5. A message indicates that calibration has been
completed.

When your C-Pen is calibrated the Text Quality icon in
the status field changes appearance.

Text Quality icon
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System Settings

 • PIN code

You can control access to your C-Pen by a four-digit PIN
code. Enter the PIN code setting to enable or disable
your PIN (Personal Identification Number).

When the dialog box opens, the zero in the first position
will blink. Turn Nav to select the first digit of your PIN.
Then press Nav to go the next position. Continue with
all four digits. When you have reached OK,  press Nav
and confirm the PIN in a new dialog box.

 

If a PIN code is enabled, you must enter the PIN each
time C-Pen is turned on. After three unsuccessful attempts,
C-Pen will turn off. You get three attempts each time you
start C-Pen.

Warning! If you start C-Pen by selecting DISABLE PIN

CODE in the start up dialog box, all data in C-Pen will be
lost! You can change or disable your PIN code by selecting
PIN code in System Settings.

Please remember to write down your PIN code and keep
it in a safe place, in case you forget the code!

• Contrast
Display contrast. Select the bar and turn Nav to change
the display contrast.

!
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• Menu Language
The language that C-Pen uses in its menus and dialog
boxes. Select the desired menu language in the list of
check boxes.

• Font
The font size on C-Pen’s display can be altered
between Large (default) and Small. Large gives a
3 row display and Small gives a 4 row display.

• Power-off time
The duration of inactivity in minutes before C-Pen turns
off automatically.

• Left/Right Hand
A Left/Right-handed option. Check Left or Right to
orientate the text on the display for left- or right-handed
use. Select OK and press Nav.

• Exchange Trigger/ESC
The option to exchange the functions of Trigg and ESC.
Checked box means normal use, see Parts of C-Pen, p.
12.
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Info
Info contains a list of help and information topics. Press
Nav or ESC to close the topic. The topics are:

• Exit
Exits Info.

• Getting started
Instructions on how to perform a successful reading.

• Troubleshooting
Solutions to common problems.

• Support
Support addresses to C Technologies.

• About C-Pen
Contains OS (Operating System) version numbers and
serial number. You should have these numbers available
when you contact C Technologies for support.

The amount of free memory space is also given. If the
scroll bar is present, select it and turn Nav to scroll
through the information. To close the topic, deactivate
the scroll bar by pressing Nav or ESC, then select OK or
press ESC.
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Storage 
Storage is a storage area for computer files, that can be
used as a floppy disk.

Selecting a file in Storage opens a menu with the follow-
ing menu items:

• Open
Opens the selected file.

• Delete
Removes the selected file.

• Properties
Displays the selected file size, creation date and date of
last modification.

• Beam
Transfers the selected file by IR, see p. 64.

• Cancel
Cancels the menu.

To be able to use Storage, C-Pen must be connected to a
PC and C Win Software must be installed. See Using C-Pen
with your PC, p. 71.

To start Storage, you must connect your C-Pen to your PC
by double-clicking the My C-Pen icon on your PC. Stor-
age is started by double-clicking the Storage icon in C-
Pen Viewer on your PC. Files which can be edited in C-Pen
Edit (e.g. filename.txt) are opened by double-clicking the
files. Other file types can be opened in two ways.

Copy the file to a temporary folder on your PC and then
open it with its default Windows application.
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Double-click the file and you will be asked if you want to
open a copy instead. Choose to open a copy.

In these cases, if you edit the file and save it, your changes
will be saved on your PC, not in your C-Pen.

Files are copied as usual in Windows, i.e. either by using
drag-and-drop or Copy/Paste in the Edit menu. See Copy
and Paste in the PC Environment, p. 75.

You can delete files in Storage by selecting the file/files
you wish to delete and then pressing the Delete button on
your keyboard. The Delete command is also available in
the File menu. Please note that this operation cannot be
undone.
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C Beam
C Beam is used to transfer notes and other files between C-
Pen and PDAs (Personal Digital Assistant). C Beam supports
the standard infrared protocol IrOBEX.

Please note that the PDA device must support the standard
infrared protocol IrOBEX in order to be used with C-Pen.

If you should experience problems with C Beam, start by
turning off and on both C-Pen and the PDA device.

Receiving files
In order to receive information files from a PDA device with
your C-Pen, follow the steps below.

1. Make sure that the C-Pen’s IR-eye is directed towards the
PDA device’s IR-eye.

Please note that it is very important that the IR-eyes are
aligned and in range of each other (5-20 centimeters, or 2-8
inches). There must be no obstacles between the devices.

2. Send the file from the PDA device according to the
instructions in the  PDA’s user manual.

3. If the PDA is equipped with a language extender, make
sure you have selected the proper character set in
Beam Settings/Receiving files, see p. 56.

4. The IR-symbol in C-Pen’s status field indicates
activity. The Receive dialog box appears on the
screen, displaying the name of the transferred file.

5. You can cancel the transmission at any time by
pressing CANCEL in the Receive dialog box.

!

!
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6. After transmission the Accept dialog box is displayed,
asking if you want to accept the transferred file.

7. If you press YES the file will be saved in the
appropriate place,  i.e. a text file is saved in Notes.
Files not compatible with any of the C-Pen
applications are saved in Storage.

If you press NO, C-Pen will discard the received file and
no further action will be taken. You must repeat the trans-
mission if you press NO by mistake.

Please note that in order to receive several files you must
answer either YES or NO in the Accept dialog box after every
transferred file.

Send files
To send information files from your C-Pen to a PDA device,
follow the steps below.

1. Make sure that the C-Pen’s IR-eye is directed towards
the PDA device’s IR-eye.

Please note that it is very important that the IR-eyes are
aligned and in range of each other (5-20 centimeters, or 2-8
inches). There must be no obstacles between the devices.

2. Choose the file you want to send. You have the
following alternatives:

Send a text file. Enter Notes and select the file you want to
send, then select Beam in the menu that appears.

!

!
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Searching
dialog box

 

Send other files, saved in Storage. Enter Storage and
select the file you want to send, then select Beam in the
menu that appears.

Please note that only files can be sent, not folders.

3. C-Pen starts searching for the PDA device in order to
send the file and the Searching dialog box appears on
the screen.

 

4. During transmission, the file name is displayed in a
dialog box together with a progress bar.

5. You can cancel the transmission at any time by pressing
CANCEL.

6. When the transmission is complete a dialog box will ap-
pear, telling you whether the transmission was success-
ful, or not.

Always send files as Unicode
When sending a file, C-Pen will always try to convert from
internal format Unicode to ISO character set if possible. To

Select Beam
 in the menu

!
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prevent this automatic conversion, check the Always send
as Unicode checkbox in Beam Settings/Always send as
Unicode, see p. 56. All files will now be sent as Unicode.

Please note that this will not affect how files are received to
C-Pen.!
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C Direct
C Direct gives you the opportunity to enter text from your
C-Pen at the cursor position in any Windows program. To
be able to use C Direct, C Win Software has to be installed
on your PC. See Using C-Pen with your PC, p. 71.

The easiest way to control C Direct is from the C Direct
icon in the system tray in Windows. By clicking on the
icon, you can choose Connect, Disconnect or Exit C Di-
rect. To activate C Direct you can simply double-click on
the icon. For more information about how to use C Direct,
please click  your PC’s Start button/Programs/C-Pen/C-Pen
Help.

Using IR
To activate C Direct place C-Pen in front of the IR port on
your PC. Click the Start button/Programs/C-Pen/C Direct
or click on the C Direct shortcut on your desktop.

The C Direct icon will appear in the system tray in the
lower right-hand corner of your PC screen. The icon will be
partly yellow when C Direct is connected, otherwise the
icon is greyish.

The display on your C-Pen will show “C Direct”.

 

The C Direct icon in the system tray
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When you read text with C-Pen, it will appear as usual on
C-Pen’s display. To transfer the text to the Windows pro-
gram, direct C-Pen’s IR-eye towards the PC’s IR port. The
text will disappear from C-Pen’s display and be transferred
to the cursor position in the Windows program.

Using cable
To activate C Direct make sure C-Pen is connected to your
PC with the cable. Click the Start button/Programs/C-Pen/
C Direct or click on the C Direct shortcut on your desktop.

The C Direct icon will appear in the system tray in the
lower right corner of your screen. The icon will be partly
yellow when C Direct is connected, otherwise the icon is
greyish.

The display on your C-Pen will show “C Direct”.

 

When you read text with C-Pen, the text will be transferred
immediately to the cursor position in the Windows pro-
gram. The text will not be visible in C-Pen’s display.

The C Direct icon in the system tray

Download from Www.Somanuals.com. All Manuals Search And Download.



70

C Write (only available for latin
characters)
C Write is a feature that allows you to draw characters by
using C-Pen as an ordinary pen. C Write makes it possible
to quickly write new texts into your C-Pen but it is also an
important tool during editing.

C-Pen can track its own movement over a surface and
recognize the movement as a letter, digit or symbol. C Write
is an alternative to using the character frame when insert-
ing characters in a text.

The C Write application in the Main menu only gives
information about the function.

For further information on using C Write, see p. 31.
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USING C-PEN WITH YOUR PC
A working connection with a PC is required to install and
remove applications in C-Pen. To enable this communica-
tion certain hardware and software must be installed and
configured properly on your PC.

The following is required for IR communication:

1. An IR port. Laptops often have a built-in IR port. Refer
to your PC’s manual to find out whether your PC is
equipped with an IR port and if so, where it is located.
Most desktop PCs do not have a built-in IR port. In this
case you must use an external IR adapter. Contact your
retailer if you do not have an IR adapter.

2. Infrared drivers are included on the C-Pen CD. It is
crucial to install the infrared driver properly.

3. C-Win Software. This software is installed from the
C-Pen CD.

The following is required for cable communication:

1. Cable. The cable is included in the C-Pen package.

2. COM port (serial port). The cable should be plugged
into an available COM port on your PC.

3. C-Win Software. This software is installed from the C-
Pen CD.

Installing C-Win Software
C-Win Software and the infrared driver – if required – are
installed when you run the installation programs on the C-
Pen CD. The menu option Documentation on the C-Pen
CD contains the User's Guide  and Help. The installation
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program also enables you to view Tutorial videos, which
demonstrate how to use C-Pen for best results. Click the
file you want to read.

To install C-Win Software (C-Win):

1. Put the C-Pen CD into your PC’s CD-ROM drive and the
installation program will start automatically. If installa-
tion does not start, click the Start button/Run and  type
x:\cpen.exe, where x: denotes the CD-ROM drive.

2. To install C-Win, click Software installation.

When C-Win is installed, the installation of C-Win com-
munication settings (IR and/or cable) starts. If you have
a C-Pen with a cable connection, you can choose to com-
municate by IR, cable or both. Please follow the in-
structions.

Infrared drivers might already be installed on your PC.
The installation program will tell you if this is the case.

Infrared hardware on laptops can be configured in many
different ways. Please follow the instructions in the in-
stallation program. If you have questions about IR com-
munication, please click the Start button/Programs/C-
Pen/Troubleshooting or go to www.cpen.com/support
and click on Troubleshooting, or contact your laptop
retailer or manufacturer.

Connecting C-Pen to a PC by IR
To connect C-Pen to your PC, position C-Pen so that it is
aligned with the PC’s IR port as shown in the figure.

Download from Www.Somanuals.com. All Manuals Search And Download.



73

The installation program will place a C-Pen icon (My C-
Pen) on your PC’s desktop. When C-Pen is within range of
the PC’s IR port you can double-click on the icon. If
communication is established between the PC’s IR port
and C-Pen, a communication icon will appear in the status
field on C-Pen’s display. 

On most laptops the built-in IR port - a red or black shiny
plastic square - is found on the back or side of the com-
puter.

Connecting C-Pen to a PC by Cable
To connect a C-Pen to your PC, plug in the cable in C-Pen
and in an available COM port on your PC.
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The installation program will place a C-Pen icon (My C-
Pen) on your PC’s desktop. When C-Pen is connected to
your PC you can double-click on the icon. If the cable
connection between C-Pen and the PC is in order, a com-
munication icon will appear in the status field on C-Pen’s
display. 

Getting Help
To get more detailed help using C-Win, open C-Pen Viewer
(by double-clicking on the  My C-Pen icon), from the Help
menu select the C-Pen Help Topics. Or click your PC’s Start
button/Programs/C-Pen/C-Pen Help. You can also press F1
on the PC keyboard to enter the C-Win Software Help.

C-Pen Viewer
Open C-Pen Viewer by double-clicking on the My C-Pen
icon. C-Pen Viewer enables you to browse the contents of
your C-Pen.
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The user interface looks like Windows Explorer and you
will recognize the applications from the main screen in C-
Pen. Use C-Pen Viewer to open and browse files in your C-
Pen, to create new folders and to remove applications from
your C-Pen.

Your C-Pen Viewer might look different from the figure
above, depending on which options you have enabled in
the Explorer’s View menu.

Copy and paste in the PC Environment
In the C-Pen Viewer you can view the details of the pen and
also perform copy and paste operations.

One way of copying and pasting files is to use the Edit
menu at the top of the active window on your desktop.
Select the file you want to copy by clicking on it once.
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Then click the Edit menu and select Copy in the menu that
appears. Select the folder in which you want to put the
copy. Then click the Edit menu and  select Paste. A copy
of the file is now placed in the selected folder.

Another way is to use “drag and drop”. Click the file you
want to copy and keep the mouse button down. While keep-
ing the mouse button down, move the mouse to point at
the folder where you want to copy the file. Release the
mouse button when the folder becomes highlighted. The
file is now copied to the folder.

Installing and Removing Applications
The applications in your C-Pen can be removed and new
ones can be installed in the C-Pen Viewer. The C-Pen
application’s file name is “.car” (C-Pen Archive). The files
do not have to be placed in any specific folder on your PC,
C-Pen will find them regardless.

To install a new application in C-Pen simply double-click
on the “.car” file you want and installation will begin. You
have to turn C-Pen off and on again to complete the pro-
cess.

To remove an application from C-Pen select the applica-
tion in the C-Pen Viewer and choose Uninstall C-Pen Ap-
plication from the File menu and follow the instructions
on the screen. You have to turn C-Pen off and on again to
complete the process.

Some applications are part of the basic C-Pen functional-
ity and cannot be uninstalled. To see if it is possible to
uninstall an application, select it and open the File menu.
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The application can be uninstalled if the menu option
Uninstall C-Pen Application is enabled.

Transferring Files
There are two ways to transfer files to and from C-Pen.
Either between a PDA and C-Pen, or between C-Pen and a
PC. It’s practically the same as working with a floppy disk
or a hard drive.

Transferring files to and from a PC
Before transferring files you have to double-click on the
My C-Pen icon on your PC in order to open the C-Pen
Viewer. See C-Pen Viewer, p. 74.

Please note that it is very important that communication
functions properly. The IR-eyes of your PC and C-Pen
must be aligned and in range of each other (5-20 centime-
ters or 2-8 inches). There must be no obstacles between
the devices. If you use the cable, make sure that the cable
is properly connected at both ends.

Find the file you want to transfer (e.g. a text file in Notes)
and select it. Then copy the file and paste it into the
desired folder on your PC. Please read Copy and paste in
the PC Environment, on p. 75.

When transferring files from the PC to C-Pen, remember
that each application accepts only its own kind of files.
Notes, for example, may only contain text files. Other file
types can be saved in Storage, see Storage, p. 62.

!
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Transferring files to and from a PDA device
Files can be transferred to and from PDA devices if the PDA
device supports the standard infrared protocol IrOBEX. Files
are transferred with the application C Beam, see p. 64.

C Direct
C Direct allows you to enter text from your C-Pen directly at
the cursor position in any Windows program.

The C Direct application in the C-Pen main screen only
gives information about the function. C Direct is activated
from the PC and communicates by IR or cable. For further
information on how to use C Direct, see p. 68.

C-Pen Edit
C-Pen Edit is a simple text editor that provides basic text
editing functions, such as cut, copy, paste, find and re-
place. It can communicate directly with your C-Pen to open
and save files, when C-Pen and your PC are connected.

C-Pen Edit lets you edit files stored in C-Pen directly on
your PC, without having to first move them to your PC.
Double-click a text file in Notes in the C-Pen Viewer, and it
will automatically be opened in C-Pen Edit. An opened
file from C-Pen can be saved either to your PC or directly
back into C-Pen. The same applies when you open a file
from your PC. 
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Closing the Connection
Close the connection between your C-Pen and your PC by
selecting Disconnect C-Pen from the File menu in the C-Pen
Viewer.
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TECHNICAL SPECIFICATIONS
C-Pen 600MX
Size: 140 x 35 x 24 mm (5.5 x 1.38 x 1.0 inches)

Weight: 80 g (3 oz) including batteries

Display: 3 or 4 rows

Flash memory: 6 MB

RAM: 4 MB

Battery: 2 x AAA, type LR03

Battery lifetime: 3-4 weeks of normal use

Reading speed: 15 cm/s (5 inches/s)

Character sizes: 5–22 points
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WARRANTY
C Technologies AB warrants that this product is free from defects in

materials and function at the time of original purchase and for a

period of one year from that date. When the name C Technologies is

mentioned in the following text, it means, unless otherwise stated, C

Technologies AB (reg. number 556532-3929), its subsidiaries and

retailers.

If, during the warranty period, any defect in the product arises due to

a deficiency in materials or function, C Technologies pledges to, at C

Technologies’ option, either repair or replace the defective product

with the same or an equivalent model.

C Technologies, however, takes no responsibility for:

1. Damage caused during shipping, by accidents, malicious

damage, modification, incorrect usage, force majeure or any

cause beyond the control of C Technologies, including but not

limited to lightning, water, fire, public disturbances, riots,

strike, war or other similar conflicts.

2. C Technologies is not responsible for damage (including but

not limited to direct or indirect personal injury, lost profits, fall

in production, losses of or alteration to processed information

or any other incidental or consequential damages) caused by

the product or the usage of the product or because the product

cannot be used.

3. Deficient maintenance or a repair performed by unauthorized

persons.

4. Incompatibility due to technological developments.

5. Defects caused by external equipment or abnormal wear.

6. Defects caused by normal wear and tear.
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7. Damage caused by the usage of inappropriate battery.

8. Damage arising in connection with or as a consequence of

upgrading with additions to or alterations of the product, using

software or hardware not produced by or approved by C

Technologies.

If your C-Pen product requires warranty service you should return

the product to the dealer/retailer from whom it was purchased. The

product must be packed in original packaging or with sufficient care

so as to avoid shipping damage. The original purchaser must be able

to show proof and date of purchase with receipt/invoice from point

of purchase in order for this warranty to be valid.

Repair or exchange does not extend or renew the warranty period.

Exchanged defective parts become the property of C Technologies.

When the warranty period has expired, the warranty of exchanged/

replaced parts also ceases.

This product is not to be regarded as having defects in materials or

function if it must be rebuilt in order to be modified in accordance

with national or local technical safety regulations in a country other

than one that the product was meant to be used in.

C Technologies reserves all rights to the product, its hardware, soft-

ware and trademark. Whoever buys or uses the product has no right

to alter, disassemble, reverse engineer or in any other way use any

part of the hardware or software in the product, except in the way

and for the purposes permitted by law.
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LIMITED WORLDWIDE WARRANTY

To the extent such dealer/retailer has joined C Technologies’ world-

wide warranty program, you may, in addition to returning the prod-

uct to the dealer/retailer from which it was purchased, also return the

product to any dealer/retailer in the world carrying such product.

To the extent permissible under law, the warranties provided herein

are exhaustive and constitute the sole and only warranties provided

by C Technologies AB.

C TECHNOLOGIES’ LIABILITY IN TORT (INCLUDING NEGLIGENCE) OR ARIS-
ING OUT OF ANY AGREEMENT FOR THE SALE, USE OR SUB-LICENSE OF THE

PRODUCT SHALL BE LIMITED TO THE AMOUNT PAID BY PURCHASER FOR

SUCH PRODUCT. IN NO EVENT, THE COMPANY WILL BE LIABLE UNDER ANY

THEORY OF LIABILITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY OR CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE WHATSO-
EVER, SUFFERED BY THE PURCHASER, OR ANY OTHER PARTY, ANY END-
USER, CUSTOMER, RESELLER, OR ANY DISTRIBUTOR, INCLUDING WITH-
OUT LIMITATION, LOST PROFITS, BUSINESS INTERRUPTIONS, LOSS OF DATA,
OR OTHER ECONOMIC LOSS ARISING OUT OF THE POOR PERFORMANCE OR

NON-PERFORMANCE HEREUNDER OR ANY USE OF OR FAILURE TO BE ABLE

TO USE THE PRODUCT, EVEN IF SUCH PARTY HAS BEEN ADVISED OF THE

POSSIBILITY OF SUCH DAMAGES AND NOTWITHSTANDING THE FAILURE OF

ESSENTIAL PURPOSE OF ANY LIMITED REMEDY.

C TECHNOLOGIES MAKES AND PURCHASER RECEIVES NO WARRANTIES,
OTHER THAN THOSE EXPRESSLY STATED IN THIS DOCUMENT, OR CONDI-
TIONS ON THE PRODUCT, EXPRESSED, IMPLIED, CONTRACTUAL OR STATU-
TORY, AND C TECHNOLOGIES SPECIFICALLY DISCLAIMS ALL OTHER WAR-
RANTIES AND REPRESENTATIONS INCLUDING WITHOUT LIMITATION ANY

IMPLIED WARRANTY OF MERCHANTABILITY, NON-INFRINGEMENT OR FIT-
NESS FOR A PARTICULAR PURPOSE, ANY WARRANTIES ARISING FROM A

COURSE OF DEALING, USAGE OR TRADE PRACTICE AND ANY WARRANTIES

CONCERNING THE NON-INFRINGEMENT OF THIRD PARTY RIGHT.
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Warranty Information

Serial number:

Customer:

Date:

Address:

Dealer:

Address:

CT number:
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DECLARATION OF CONFORMITY
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UL STATEMENT

All UL-labelled C-Pen products fulfill the requirements of
the UL 1950 standard: UL Standard for Safety of Informa-
tion Technology Equipment.

C-Pen models with built-in rechargeable batteries are to be
used with Direct Plug-In Transformer unit marked
“Class 2” rated from 4.05-4.95 Vdc, 450-550 mA.

The built-in rechargeable batteries are not operator
accessible or replaceable.
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C DICTIONARY COPYRIGHT NOTICE
Copyrights for the following dictionaries are held by their
respective publisher. Copyright information for additional
titles from current and/or additional publishers made avail-
able by C Technologies after this publication goes to print
will be listed at www.cdictionary.com.

• Norstedts Ordbok is a trademark of Norstedts Ordbok
HB, Teknologgatan 8c, Stockholm, Sweden

• Norstedts engelska (Engelsk-svensk/Svensk-engelsk)
ordbok
Copyright © 1994 Norstedts Ordbok AB, All rights
reserved

• Norstedts tyska (Tysk-svensk/Svensk-tysk) ordbok
Copyright © 1998 Norstedts Ordbok AB, All rights
reserved

• Norstedts fransk (Fransk-svensk/Svensk-Fransk)
ordbok
Copyright © 1989 Norstedts Ordbok AB, All rights
reserved

• “Oxford University Press” and “Oxford” are registered
trademarks of Oxford University Press, Great
Clarendon Street, Oxford, England

• Concise Oxford Thesaurus © Oxford University Press
1995 –Additional Material © Market House Books
Ltd. 1995

• Concise Oxford Hachette French Dictionary © Oxford
University Press 1995, 1998
© Hachette Livre 1995, 1998
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• Concise Oxford-Duden German Dictionary © Oxford
University Press and Bibliograpisches Institut & F.A.
Brockhaus AG 1991, 1997, 1998

• Concise Oxford Spanish Dictionary © Oxford Univer-
sity Press 1995, 1998

• Oxford Zanichelli Concise Dictionary ©1997
Zanichelli editore S.p.A.

• Concise Oxford Dictionarv 10th edition © Oxford
University Press 1999

• “Merriam-Webster’s”  is a registered trademark of
Merriam-Webster Incorporated, 47 Federal Street,
Springfield, Massachusetts, USA

• Merriam-Webster’s Collegiate® Dictionary Copyright
© 2000 by Merriam-Webster, Incorporated

• Merriam-Webster’s Collegiate® Thesaurus Copyright
© 1988 by Merriam-Webster, Incorporated
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B
Battery  17
Battery Compartment  14
Battery power level  18
Beam Settings  56

C
C Beam  7, 39, 64

Accept dialog  65
Folders  66
Installing C Beam  64
Receive dialog  64
Save files  65
Searching dialog  66
Using C Beam  64

C Dictionary  7, 39, 45
Dictionaries button  52
Dictionary licence key  47
Exit C Dictionary  53
Info button  53
Installing a dictionary from

C-Pen CD  45

Installing a dictionary from
the web  46

Remove dictionary  47
Text language  52
Translation screen  50
Word edit box  49
Word references  50
Word selection list  51
Word selection screen  51

C Direct  7, 39, 68
Using cable  69
Using IR  68

C Read  7, 22, 41
C Write  7, 31, 40, 70

Basic rules  32
C Write Feedback  32
C Write Prototypes  35
Capital letters  33
Symbols  33
Using C Write  32

C Write Prototypes  35
C-Pen

Battery Compartment  14
Camera Opening  14
Reset  19

C-Pen 600C
Cable Connector  13

C-Pen 600MX  6
C-Pen Edit  78
C-Pen models  5

C-Pen 600MX  6

C-Pen Viewer  74
Cable communication

C-Win software  71
Cable  71
COM port  71
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Cable Connector  13
Calibration  56

How to...  58
Quick  57

Camera Opening  14
Character set  28
Character size  9
Check box  15, 21
Closing the connection  78
Command menu  42
Connecting C-Pen to a PC by

cable  73
Connecting C-Pen to a PC by

IR  72
Contrast  59
Copy and paste on a PC  75

Drag and drop  76
Edit menu  75

Creating a folder  41
Cursor  43

D
Dialog box  16
Dialog button  16, 20
Dictionaries button  52
Dictionary licence key  47
Display  13
Display object  14
Download dictionary  46

E
Edit field  16, 20

Edit menu  26
Change  31
Cut, Copy and Paste  30
Delete  30
Insert  29
Quit Editing  31
Select  30
Settings  30

Edit mode  26
Editing text  26

C Write  31
Edit menu  26
Edit mode symbol  26
Entering edit mode  26

ESC  13
Exchange Trigger/ESC  60

F
Features  7
File  41

Beam  43, 62
Creating a new file  41
Delete  42
Open  42
Properties  43
Rename  42

G
Getting started  17

Battery  17
Turning C-Pen On and Off
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H
Help  10
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I
Info  39, 61

C-Pen facts  61
Getting started  61
Troubleshooting  61

Infrared drivers  71
Installing

Applications  76
C-Win Software  71

Installing a dictionary from C-
Pen CD  45

Installing a dictionary from the
web  46

Installing C Beam  64
Installing C-Win software  71
Introduction to C-Pen  5
Inverted text  55
IR communication

C-Win software  71
Infrared driver  71
IR port  71

IR port  13, 73
Ir protocol  64

L
Language, setting  55
Left/Right hand  60

M
Main screen  15
Menu  15, 20

ESC  20
Selecting  19

Menu language  60

N
Nav  13
Navigation control (Nav)  19
Notes  41

Command menu  42
Create new file or folder  41
Edit / C Write  44
List of text files  40
Text menu  43
Using C Read/Notes  41

O
OCR  8
On/Off button  13, 17
Optimum reading conditions  8

P
PDA  64
Power off time  60

R
Read Mode  55
Read mode

Line break  55
Tab  55

Reading conditions  8
Reading text  22

Deleting a line  24
Text screen  24

Remove dictionary  47
Removing applications  76
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S
Saving text  25
Selecting  19
Settings  39, 54

Beam Settings  56
C Write Feedback  32, 56
Calibration  56
Modify a setting  54
Read Mode  55
System settings  59
Text Language  55
Text Quality  55

Status field  14
Storage  8, 62

Delete file  62
File properties  62
Open file  62
Using Storage  62

Support  10, 61
System Settings  59

Contrast  59
Exchange Trigger/ESC  60
Font  60
Left/Right Hand  60
Menu Language  60
PIN code  59
Power off time  60

T
Technical Specifications  80

C-Pen 600C  80

Text colors  9
Text, inverted  55
Text Language  55
Text Language icon  14, 18

Text menu  43
Text Quality  55
Text Quality icon  14, 18, 58
Text screen  24
Text settings  54
Transferring files  77

Copy and paste  77
To/from your PC  77
To/from your PDA  78

Trigg  13
Troubleshooting  10, 61
Turning C-Pen On and Off  17

U
Using C Dictionary  48
Using C Direct (cable)  69
Using C Direct (IR)  68
Using C-Pen with Your PC

71
C Direct  78
Cable communication  71
Closing the connection  78
Getting help  74
IR communication  71

Using C-Write  31
Using Notes/C Read  41
Using Storage  62
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